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* * * * * * * * * * * 

1. 
Quick Start 

Open a Book 
2. View Text 
3. Look up a Reference 
4. Search for Words 
5. Display Search Results 

 
* * * * * * * * * * * 

To open a book, select the File menu and click Open…. With the Open Book dialog box do the 
following. 

Open a Book 

1. Select the library 
2. Select a bookshelf (e.g., language) 
3. Select a bookshelf (e.g. Scriptures) 
4. Select a book 
5. Click OK. 

 
* * * * * * * * * * * 

The text of an electronic book is displayed in a text window which has the following features. 
View Text 

1. A line at the top with the book name. 
2. The citation for the current location is on the second line. You can use this citation to look up 

any reference. 
3. Search for a word by double clicking on it. 
4. Click on a hyperlink to jump to that location. 
5. Menus give access to other functions. 
 

* * * * * * * * * * * 
  



This function finds a reference. If you wanted to find 1 Nephi 3:7 in the Book of Mormon, you 
would do the following. 

Look up a Reference 

1. Open the LDS Scriptures. If the book is already open, click on the up-arrow in the upper left 
corner. 

2. Click on the word Title in the upper left corner. This will cause a list to appear 
3. Click on Book of Mormon in the list. A new list of the books of the Book of Mormon will 

appear. 
4. Click on 1 Nephi in the list. A new list of the chapters in the First Book of Nephi will appear. 
5. Click on 3 in the list. A new list of the verses in the 3rd Chapter will appear. 
6. Click on 7 in the list. The list will automatically close and you are at your destination. 

If you are not at the top of the book you can still click on the first part of the reference to see 
the list. From that start, begin the process in step 3. 
 

* * * * * * * * * * * 

1. To open the Search dialog box, do the following. 
Search for Words 

a. From a text window: click on the Book menu and then click on Search for word(s). 
b. From a results window: click on the Results menu and then click on Search for word(s). 

2. Search for a word 
a. Select the word list. 
b. Type the word in the Find box and click "View". 

3. Search for a phrase: 
a. "and it came to pass" finds this exact phrase. 
b. ‘and came pass’ finds phrases containing these words. 
c. and it came to pass finds the verses with all these words 
d. If you type and [space] &.5 [space] pass in the search box, the software finds and 

within 5 words of pass. 
e. The &.5 is called search logic and it is represented in the Find box with a different 

background color than the search words. The Search Logic dialog box can be used to 
select the &.5. 

f. See the tutorial on searching for more information about searching. 
4. Search using bounds: 

a. If your book has sections bounds, you will see a list of these bounds under the check box 
labeled “Use bounds.” 

b. After you place a Check in that box, you will be able to select your search bounds from 
one of those listed. 

c. Only search hits within those selected bounds will be displayed in Search Results. 
5. Menus 
 

* * * * * * * * * * * 
 
  



After creating a search in the Search dialog box and either pressing the [return] key or clicking 
the View button, you will see the results in the Search Results Window. The features of this 
window are listed below. 

Display Search Results 

1. This window persists from one search to the next. 
2. You can scroll side-ways from a text window to see this list. 
3. At the top of the window is the list title and the size of the list (e.g. List 1 [2,260] ). 
4. The Book combo box lists all the books involved in the search (e.g. the books from a search of 

all open books). Selecting a book causes the search hits from that book to be displayed. 
5. There are several windows that display text around a search hit. Each has a number in the 

upper left corner that represents which of the possible search hits it is displaying. To the 
right of the number is the citation for that search hit (e.g. where the search hit is found in 
the book). 

6. Menus 
 

* * * * * * * * * * * 
 

This is a list of some of the features of the Windows Mobile Edition of LDS View. 
List of Features 

1. Any LDS View text can be displayed. The text features supported include hyperlinks, 
synchronized footnotes, graphics, formatted text and searching for selected text words. 

2. The same search system is used as the Resource and Standard Editions. 
3. Multiple books can be open at the same time. Similar texts that are synchronized will move 

simultaneously even if you can't see a text window. All the scripture texts of LDS View are 
designed for this automatic synchronization. 

4. Scrolling side-ways allows you to see other windows (with other books) as if they were 
side-by-side. 

5. You can personalize your study with Bookmarks, Searchable notes (not released yet) and the 
highlighting of words (not released yet). 

 
 
  



>>>>>      <<<<< 
* * * * * * * * * * * 

1. 
Tutorials 

The Installation Process 
2. Library 
3. Searching 
4. Search Results 
5. Bookmarks 
6. Book Preferences 

* * * * * * * * * * * 

1. Adding books to the library 
Tutorial 1: The Installation Process 

a. Access the website where the "book" files (electronic library installation modules – ELIMs) 
are found.  

b. Download the ELIM to your computer. It is often faster to download an ELIM to a desktop 
computer and then transfer it to a mobile device connected to the desktop computer. 

c. Click on an ELIM to install all of its data into the LDS View library. 
2. Run the software and open a book. 

 
* * * * * * * * * * * 

These subjects are covered below. 
 Tutorial 2: Library 

1. LDS View Libraries 
2. Other library features 
3. Common uses for the library 

LDS View Libraries 
1. All libraries accessed with LDS View are locked and you can't edit the library. 
2. An empty library was put on your computer when you first installed LDS View. 
3. Each time you download an electronic library installation module (ELIM) and click on it, a 

book is added to your library. 

Other Library Features 
1. Automatic synchronization – with the LDS View library Scriptures in different languages 

automatically synchronize with each other. If you open the English scriptures, the Spanish 
scriptures and the Portuguese scriptures and move around in English, the other books will 
track your movements in synchronization. Where data is not present in one of the books (e.g., 
the Bible in Portuguese) it positions as closely as possible. 

2. Electronic Library Installation Module – this feature allows you to install or remove electronic 
library installation modules. 
a. With LDS View, you may have added items to a library from ELIMs and you may not have 

permission to directly remove them (because the library is locked). 
b. For items you installed from ELIMs, there is a menu feature called Installed Modules that 

brings the Installed Library Modules Dialog Box to the screen. 
c. You can select from a list of the installed ELIMs and then click the Uninstall button. 
d. This removes items from the library and deletes the files from your computer. 

3. Open Book Dialog Box Menus 



 
Common Uses for the Library 
1. Use the Installed Library Modules Dialog Box to remove from and add books to the LDS View 

library. 
2. Change the display options for a Book. 
3. Create or delete a Custom Word List. 
 

* * * * * * * * * * * 

 Tutorial 3: Searching 

1. Select the book in the Search combo box 
 3.1 Introduction 

a. If you came from a Text Window to the Search dialog box the book associated with that 
window will be automatically selected. 

b. If the Search dialog box is called from the Search Results Window menu, the last book 
used in searching will be selected. 

c. You can override the default selection in the Search combo box. If you have more than one 
book open, you will be able to select the option to search all the open books. 

2. Select the word list 
a. When you make a selection in the Search combo box, the possible word lists are displayed 

in the Word list combo box. The names of the word lists are generally self explanatory. 
b. Any given word in a book can be assigned to only one word list. Where a book like the 

scriptures is separated into several types of word lists, it is highly likely that frequently 
occurring words will occur in every word list. 

c. You can use Custom Word Lists to create your own combination of words lists (e.g. 
Scriptures + Preface + Headings). 

3. Build a search – the LDS View search system supports searches from very simple single word 
searches to complex multiple word searches. This additional tutorial help will step you 
through the process of building increasingly complex searches if you need them. 

4. Use bounds with your searches – if you see data in the combo box below the bounds check 
box then sections are available to bound searches. Select Use bounds and then select a 
section before viewing the search results. 

5. View the search results – after typing a search press the [return] key or click the View 
button. 

 
* * * * * * * * * * * 

  



When you perform a search using the Search dialog box, the information you enter in the Find 
box is called a search argument. There are three parts to each search argument. 

 3.2 Build a Search 

1. Search expression – the following are the possible expressions. 
a. Words, Subwords and Tagwords 
b. Wildcards 
c. Groups of Words 

2. Search Logic – you can enter your search logic by either typing the logic or by using the 
Search Logic dialog box to select the logic. The search logic separates expressions and 
consists of following. 
a. Boolean Logic (e.g., and, or) 
b. Type (Word Proximity, Word Level) 
c. Range, Level and Order 

3. Order-of-Operations 
a. Default order of operation 
b. Parentheses 
c. Exact phrase 
d. Partial phrase 

The first word (or if an expression is first, the first word in expression) in a search argument is 
called the anchor word. Search results displays are centered on the anchor word. 

 
* * * * * * * * * * * 

Words are composed of both letters and numbers. The words associated with the selected word 
list can be displayed on the WordWheel of the WordWheel Dialog Box. 

 3.2.1 Words 

There are three ways of doing word searches. 
1. Type a word in the Find box. The default word list associated with this word is the selected 

word list in the dialog box. It can be overridden with the Attributes of Word Dialog Box. The 
default language associated with the word is the language associated with the selected 
search book and word list. This can also be overridden by the Attributes of Word Dialog Box. 

2. Double click on a word in the WordWheel and you will immediately see the Search Results 
for the word. If you just select the word and then press the OK button, the word will be 
inserted into your current search. If you select multiple words and click the OK button, all of 
them will be inserted into your current search. 

3. Double click on a word in a Text Window. This is not part of the Search Dialog Box. The 
Search Results appear exactly the same is if you typed the word in the Search Dialog Box or 
selected it from the WordWheel Dialog Box. The word list associated with this word comes 
from its context in the book. 

 
* * * * * * * * * * * 

  



Subwords in LDS View are punctuation marks. If you scroll to the bottom of the Scriptures word 
list you will see them. If “Ignore Type” is off, they have a small superscript "s" to indicate the 
"word" is a subword. 

 3.2.2 Subwords 

Below is an example of a search that uses a subword. 
1. We want to find every question in the scriptures that ends in thou. We want the proximity to 

be zero words because the subword occurs between thou and the next word in the book 
(most likely the start of the next sentence). 

2. To find our examples we type: thou [space] &.0 [space] ^? [space] 
3. The caret (^) is used before the question mark to inform the software we are looking for the 

character question mark (not the wildcard character command). 
4. If “Ignore Type” is off, the spell checker added a small white S in a purple box after the 

question mark to indicate this "word" is a subword. 
5. The menu associated with the Symbols button in the Search Dialog Box will also insert the 

^? to the search. 
 

* * * * * * * * * * * 

Tagwords in LDS View scriptures are found in the word list called "Topics". These topic words 
are assigned to verses and are the topics found in the Guide to the Scriptures. 

 3.2.3 Tagwords 

Below is an example search that uses a tagword. 
1. Select the Topic word list. 
2. Type liahona and press the space bar 
3. If “Ignore Type” is off, the spell checker added a small white T in a purple box after the 

typed word to indicate this word is a tagword. 
 

* * * * * * * * * * * 

You can expand your searches by including the following wildcard characters. 
 3.2.4 Wildcards 

1. Asterisk (*): The asterisk stands for 0 to 250 characters (the maximum length of any indexed 
word in this software is 250 characters). 

2. Question mark (?): The question mark stands in place of a single character. 
Below are some examples of wildcard expressions and their potential search hits. 
1. be*ing - finds words like: being, beginning, bearing, belonging, beholding, and so on. 
2. *work* - finds words like: breastwork, fellowworkers, needlework, work, workers, 

workmanship, and so on. 
3. war? - finds words like: ward, ware, warm, warn, wars, wary, and so on. 

Note that the question mark forces each of the matching words to be four characters in length. 
4. *war?* - finds words like: aware, backward, swarm, ward, wards, ware, warm, warming, 

and so on. Note that the question mark forces each of the matching words to be at least four characters in 
length (one character after war). 

 
* * * * * * * * * * * 

  



The following types of word groups may be used in searching. Pressing the space bar is an 
important part of entering phrases.  

 3.2.5 Groups of Words 

1. Default Phrase - these words have a space between each word. The space is interpreted as 
the default space. 

2. Exact Phrase - these words are surrounded by double quotes with a space between each 
word. An exact phrase changes the meaning of the default space and the order of operations. 

3. Partial Phrase - these words surrounded by single quotes with a space between each word. 
A partial phrase changes the meaning of the default space and the order of operations. 

4. Parentheses Phrase - these words are surrounded by parentheses. The parentheses around 
the phrase changes the order of operations. The individual words in this phrase can be 
separated with specified search logic. 

5. Specified Phrase - these words are separated by logic that you have specified by using the 
Search Logic Dialog Box. 

6. Mixed Word-type Phrase - these words may each be of a different word-type. You must use 
the Attributes of Word Dialog Box to assign the appropriate word-type to each word in the 
group of words. For multilingual documents, this same dialog box can be used to assign a 
different language to each word in a group. 

 
* * * * * * * * * * * 

The Search Logic dialog box is available from the Search menu of the Search dialog box. 
 3.2.6 Selecting Search Logic 

1. When you use the Search Logic dialog box to build search logic, both Proximity and Word 
Order are set with the same options that change the Type selection. 

2. The Word order is implied by the "Range before" and "Range after" values. 

The process of selecting the search logic is a matter of following the numbers that appear with 
the descriptions. 

1. Select a type of logic. As you change your selection in the first group of radio buttons, the 
options in the other radio button groups change. The Or and Default options have no other 
selections. 

2. Select word source. Your choices are as follows. 
a. (NOTE) Words: choose this option if one of the following is true. 

1) Both the expressions are words. 
2) One expression is a word and the other is a subword or tagword (see example). 
3) One expression is a subword and the other expression is a tagword. 

b. Subwords: the expressions in your search argument must be only subwords (words that 
occur between normal words, e.g. punctuation and publisher furnished commentary). 

c. Tagwords: the expressions in your search argument must be only tagwords (words 
attached to normal words, e.g. part-of-speech codes and definitions). 

3. The abbreviation used in the search logic feedback is linked to this word source. If you have 
chosen Words as your source, you will see W1 and W2 in the description. If you have 
chosen Subwords as your source, you will see S1 and S2 in the description. If you have 
chosen Tagwords as you source, you will see T1 and T2 in the description. 

4. Proximity: the options available depend upon the word source choice. 
5. Word Order: the options depend upon the word source choice. 



 
* * * * * * * * * * * 

1. The best way to learn the search logic codes is by selecting search logic and copying the 
codes created by this process. 

 3.2.7 Typing Search Logic 

2. You can type in the Find Box the codes you see echoed in the title of Search Logic dialog 
box. 

3. Follow these steps to type search logic in the Find Box. 
a. After typing an expression press the [space bar]. 
b. You will see the software echo your command with a slightly different colored box within 

the Find box. 
c. Everything you type now will be interpreted as part of a logic command. 

d. When you have finished typing search logic press the [space bar] and the software will 
terminate your logic and create an empty location for you to type the next word. The cursor 
is automatically correctly positioned for this typing to begin. 

* * * * * * * * * * * 

Boolean logic is the type of search operation you desire. The four possibilities are listed below. 
 3.2.8 Boolean Logic 

1. And: both expressions must be present to get a search hit. 
2. Or: either expression being present becomes a search hit. 
3. Not: the first expression must be present without the second expression being present. 
4. Default: the space is the default logic character. How it is interpreted depends upon the 

search expression where the space is found. 
a. Within an exact phrase, space is interpreted as &.1,0. 
b. Within a partial phrase, space is interpreted as &.7,0. 
c. Everywhere else a space is interpreted as &.L (within the same lowest level). 

 
* * * * * * * * * * * 

Type of proximity is how far apart the words or expressions are allowed to be and still get a 
search hit.  

 3.2.9 Type of Proximity 

1. Word Proximity: the two expressions must be within a specified number of words. There is an 
option with word proximity that requires the expressions to be a exactly a precise number of 
words apart. 

2. Word Level: the two expressions must be either within a specified reference level. 
3. Subword Proximity: the two subwords must be within a specified number of subwords and 

within the same subword group. 
4. Subword Group: the two subwords must be within the same subword group. 
5. Tagword Proximity: the two tagwords must be within a specified number of tagwords and 

within the same tagword group. 
6. Tagword Group: the two tagwords must be within the same tagword group. 

 
* * * * * * * * * * * 

  



These are used to specify the range for Word Proximity searches. In Word Level searches they 
are used to specify the order of words and the levels used for search proximity. 

 3.2.10 Range, Level and Order 

We suggest that you use the Search Logic dialog box to select these values until you have them 
memorized so you can type them. 

In the explanations below the following codes are used. 
1. W1 means word 1 and W2 means word 2. 
2. S1 means subword 1 and S2 means subword 2. 
3. T1 means tagword 1 and T2 means tagword 2. 

There are two ways of representing the operators used in search logic: abbreviated and regular. 
In the examples below the regular commands are in parentheses. 
The following are the options for the "Type" combo box. 
1. Word Proximity: you specify the range before and the range after (also implies word order). 

a. &.5,3  (And.5,3) means W1 must be within 5 words before and within 3 words after W2. 
b. &.5  (And.5) means W1 can be within 5 words before or after W2. 
c. &.=5,0  (And.=5,0) means W1 must be exactly 5 words before W2. 
d. &.0,3 (And.0,3) means W1 must be within 3 words after W2. This is sometimes useful if 

you wish W1 as the anchor word (always seen in Search Results) but it is not the first 
word in the pair. 

e. #.10  (Not.10) means W1 is found where there is no W2 within 10 words. 
2. Word Level: when you select this option the Level control is added to the dialog box. The 

following are options for the "Level" combo box. 
a. Paragraph Level: W1 must be within the paragraph as W2. 

1) Before: W1 occurs before W2 
2) After: W1 occurs after W2 
3) Before/After: W1 occurs before or after W2. 

b. Lowest level: W1 must be within the same lowest level as W2. With LDS View and the 
scriptures, the lowest level is Verse or Paragraph. With conference talks or magazines the 
lowest level is paragraph. The following are the word order options. 
1) Before: W1 occurs before W2 
2) After: W1 occurs after W2 
3) Before/After: W1 occurs before or after W2 

c. Selected levels below: from a list of reference levels below this line, select which level or 
levels you wish to use as the bounds for your expression pair. Be very careful selecting 
two different types of bounds (e.g. Book, Chapter) as the results may be very confusing. 
However, similar bounds work well (e.g. if you were to do a search with Chapter, Section, 
Declaration and Preface as the bounds your command might look like And.L<.c,d,P,s). The 
following are word order options with these commands. 
1) Before: W1 occurs before W2 
2) After: W1 occurs after W2 
3) Before/After: W1 occurs before or after W2 

3. We strongly recommend you use the Search Logic dialog box for these kinds of logic 
constructs because the abbreviations for the levels will be hard to remember unless you use 
them constantly. 



4. Subword Proximity: you specify the range before and the range after (this also implies 
subword order). 
a. &.S.3,2 means S1 must be within 3 subwords before and within 2 subwords after S2. 
b. &.S.3 means S1 must be within 3 subwords before and after S2. 

5. Subword Group: both words must occur within the same subword group. The following are 
subword order options. 
a. Before: S1 occurs before S2 
b. After: S1 occurs after S2 
c. Before/After: S1 occurs before or after S2 

6. Tagword Proximity: you specify the range before and the range after (this also implies 
tagword order). 
a. &.T.3,2 means T1 must be within 3 tagwords before and within 2 tagwords after T2. 
b. &.T.3 means T1 must be within 3 tagwords before and after T2. 

7. Tagword Group: both words must occur within the same tagword group. The following are 
tagword order options. 
a. Before: T1 occurs before T2 
b. After: T1 occurs after T2 
c. Before/After: T1 occurs before or after T2 

 
* * * * * * * * * * * 

1. The default order of operations is from left to right in a search argument.  
 3.2.11 Order of Operations 

2. Parenthesis around a group of words causes a change in the order of operations. For 
example the search he (went + goes + came) would cause went + goes + came to be 
evaluated first and then those results would be combined with he. A description of the 
resulting search in LDS View would be: to find every verse or paragraph where either he 
went or he goes or he came occurs. 

3. Parentheses groups are evaluated first in a search expression. Nested parentheses are 
allowed. The innermost parentheses group is evaluated first. If two parenthesis groups have 
equal weight, they are evaluated left to right. 

4. An exact phrase group is treated as if there were a parenthesis with each double quote 
character. For example war "and it came to pass" is exactly the same as war ("and it 
came to pass"). 

5. A partial phrase group is treated as if there were a parenthesis with each single quote 
character. For example war 'and it came to pass' is exactly the same as war ('and it came 
to pass'). 

 
* * * * * * * * * * * 

  



1. The Search Results Window displays search hits surrounded by neighboring words.  
 Tutorial 4: Search Results 

2. The intent of this window is to allow you to rapidly look through your search hits to find 
precisely what you were looking for.  

3. Each search hit neighborhood is displayed in a small text window (called a reference 
window) that has its own citation. 

4. The words involved in the search are highlighted. 
5. The search anchor word is always centered in the reference window. 
6. You can see where in the book your search hits occur by displaying the Frequency 

Distribution report. 
 

* * * * * * * * * * * 

1. Bookmarks are the electronic equivalent of the piece of paper you insert into a book to allow 
you to turn to that page quickly. However, the electronic bookmark is far more precise 
because you can position to any line in a book. 

 Tutorial 5: Bookmarks 

2. The bookmark system of LDS View can save bookmarks for any book in the library. 
3. If you click on a bookmark for a book that is not currently open, the system will open that 

book and position to that bookmark location. 
4. Normally the bookmark name is the citation for the location; however, you can change the 

bookmark name to anything you want. 
5. Bookmarks are stored in a folder structure similar to the hard disk of a computer. 
6. Menu options for using bookmarks with Text Windows. 

a. Book, Add Bookmark to create a new bookmark using the Add Bookmark Dialog Box. 
b. File, Options, Bookmarks to see the Bookmarks Dialog Box. If you click on a bookmark from 

the active book, the Text Window will reposition to the bookmark location. If the bookmark 
is for another book, the system will open that book and cause the new Text Window to 
position to the bookmark location. 

c. File, Options, Organize Bookmarks to see the Organize Bookmarks Dialog Box. Use this 
dialog box to rename bookmarks, delete bookmarks and move bookmarks. 

 
* * * * * * * * * * * 

  



When books are prepared for electronic publication by the publisher, choices are made about 
the appearance of the data in the book. Many times these choices are dictated by the 
appearance of a companion printed book. 

 Tutorial 6: Book Preferences 

1. Character appearance. 
2. The size and fidelity of graphics. 
3. Word lists 
4. Reference Codes 
5. Tagwords – publishers add tagwords to books to offer alternative search terms to aid in your 

studies. 
6. Sections – publishers create sections that can be used to bound searches. 

a. The names of the sections may follow precedence from other published materials about the 
book. 

b. In the case of LDS View, some of the sections are assigned volume names. Some of the 
others are historical groupings of books. 

The display of some of these items can be changed by you. To adjust these book preferences, 
follow these steps. 
1. Open the book or BookSet. If this is not done, the options listed below will not be available. 

You can only make changes to open books. 
2. From the Text Window select Open Book again. 
3. From the library item display, select the book or BookSet again and then from the Options 

menu click on Properties. 
4. If you have a selected a book: from the Options menu of the Edit Book Dialog Box click on 

Display. 
5. If you have a selected a BookSet: from the Edit BookSet Dialog Box, select a book and click 

the Options button. A popup menu of options will appear. Click on Display to set your 
preferences. 

6. The Display Options Dialog Box has these features. 
a. From the list of Tagwords in the book, select those you wish to see. Tagwords are not 

normally displayed because they are words added by the publisher to the book; however, 
seeing them may help you understand their nature and intent. 

b. Using Show References, select those reference levels whose codes you wish displayed. 
Normally for LDS View, only the verses and paragraphs are displayed. All the other 
reference codes have duplicated names in the text (e.g. book names). You may wish to play 
with this feature by turning them all on and seeing what impact it has on the display of the 
text. 

c. Click OK to save your choices. 
 
 
  



>>>>>      <<<<< 
* * * * * * * * * * * 

Windows 

1. 
The following are the five types of windows found in LDS View Windows Mobile Edition. 

Dialog Boxes 
2. Graphics Window 
3. Main Window 
4. Text Windows 
5. Search Results Window 

 
* * * * * * * * * * * 

The Graphic window is used to display photographs and maps in LDS View. Click on an image 
displayed in a Text Window to see the same image in the Graphics Window. The toolbar is just 
above the image in the window. 

Graphics Window 

1. Toolbar 
a. Select arrow - click this icon on the toolbar and you can click on hotspot hyperlinks in a graphic. Hotspots 

hyperlinks usually point to another location in the source book. 
b. Move arrows – if you click on this icon and your image is enlarged using the zoom option, finger flick 

gestures will move the image in the direction of your gesture. 
c. Zoom in – if you click on this icon and then click on the image, it will zoom in around the click point. Click 

again and it zooms in again. You can also zoom in by clicking and dragging a rectangle over the part of the 
image you want to see in more detail. 

d. Zoom out – if you click on this icon and then click on the image it will zoom out. Click again and it zooms out 
again. 

e. Best fit - if you click this icon on the toolbar, the graphic is sized as close to its actual size as the current 
screen resolution allows. 

f. Actual size - if you click this icon on the toolbar, the graphic is sized as close to its actual size as the current 
screen resolution allows. 

g. Screen Resolution - if you click this icon on the toolbar, the graphic is sized so that one pixel of the graphic 
is represented by one pixel on your screen. This can create a zoom effect with high-resolution graphics. 

h. X icon – if you click on this icon the graphics window is closed. 
2. Menus - the menus of a Graphic Window allow you to control many of the features of the 

software and this window. 
 

* * * * * * * * * * * 

The Main window is the surface upon which all other windows of LDS View are displayed. It 
has the following features. 

Main Window 

1. The title bar – this bar displays the LDS View name and other standard Windows Mobile symbols and 
buttons. You can close the software by clicking on the X in the upper right corner of this bar. 

2. The window bar – this is a list of all the open windows in LDS View that is displayed immediately below the 
title bar. You can use a side-ways finger touch gesture on the screen to scroll into adjacent Text Windows or 
the Search Results Window. 

3. Other windows – these windows are displayed within the Main Window. 
a. Text Windows 
b. Search Results Window 
c. Dialog Boxes 

4. Menus – this menu is shown when there are no other windows being displayed. 



 
* * * * * * * * * * * 

A Text Window is the LDS View tool for displaying information from a book. It has the following 
features. 

Text Windows 

1. Citation bar – this feature contains these elements. 
a. Top-of-text button – click on this up arrow to reposition to the top of the book. 
b. Citation – this is the address of where the text in the upper left corner of the window is found. You can use 

this feature to look up a reference. 
c. Close text button – click on the X on the citation bar to close the book. 

2. Text pane – just below the citation is the text pane. It has its own scroll bar for approximate positioning of 
the text. Use the citation for quick and accurate positioning of the text. If a footnote pane is present, moving 
the location of the text pane causes the footnote pane to move its location in a synchronized manner. 

3. Footnote pane – below the text pane. This pane is only available with BookSets where one of the books is a 
footnote book. All the scripture books with LDS View have footnotes. You can use the Book: View: Footnotes 
menu option to hide and show this pane. This pane has its own scroll bar for approximate positioning of the 
text. Moving the location of the footnote pane causes the text pane to move its location in a synchronized 
manner. 

4. Hyperlinks – they can be in both panes and are displayed similar to hyperlinks on web pages. Click on a 
hyperlink and the Text Window repositions to that location. If the hyperlink is to another book in your library, 
that book will be opened and positioned to the location specified in the hyperlink. If the book is not present in 
your library nothing happens. 

5. Searching for a word – you can double click on a word in any Text Window and see all the occurrences 
of that word in the Search Results Window. The word list used in the search is the word list of the text 
location of the search word. 

6. Menus – the menus of a Text Window allow you to control many of the features of the software and this 
window. 

 
* * * * * * * * * * * 

The Search Results window is designed to display your search hits surrounded by their 
neighboring words. Below is a summary of the features of this window. 

Search Results Window 

1. Search Results Window – this window is contained within the Main window and is displayed to the side of 
any Text Windows. 

2. Top line - it contains search results list number and size. 
3. Next line - it contains a combo box with the names of all the books containing search hits.  

a. The number of books being searched depends upon selections you made in the Search dialog box. For 
example if you are searching "The Scriptures" (which includes Scriptures and Footnotes files) and your word 
list is "All Text", then your search results may occur in both the Scriptures book and its Footnotes. 

b. The name in the book list is the BookSet name and the book name is in parentheses. 
4. Small text windows - each displays text around a search hit. 

a. These windows are called reference windows. 
b. Each small window has a citation bar that lists the location of the search hit. 
c. Click on one of these windows to jump to the text window for this book and reposition the text in that 

window to the location of the search hit. 
5. Scroll bar – use it to rapidly change what the reference list text windows are displaying. If you click in the 

white space of the scroll bar the references will move a page at a time. 
6. Menus – among the menu options is Frequency Distribution that allows you to see where in the book your 

search hits occurred. 
 



>>>>>      <<<<< 
* * * * * * * * * * * 

The list below is structured around the menu items that access dialog boxes. Where a dialog box 
is accessed through menus of another dialog box it is included under its parent dialog box. 

Dialog Boxes 

1. File Menu 
2. Book Menu 
3. Results Menu 

* * * * * * * * * * * 

1. File Menu 
a. Open Book 
b. Load References 
c. Save References 
d. Bookmarks 
e. Organize Bookmarks 

1) Move Bookmark (Folder) 
2) Rename Bookmark (Folder) 
3) Attach a New Folder 

f. Options 
g. About Box 

2. Book Menu 
a. Search for Word(s) 

1) Search Logic 
2) Attributes of Word 
3) WordWheel. 

b. Table of Contents 
c. Add Bookmark 

1) Attach a New Folder 
3. Results Menu 

a. Search for Word(s) 
b. Frequency Distribution – and Details Dialog Box 

 
* * * * * * * * * * * 

Read the Tutorial on Libraries to understand more about the use of Libraries. This is a list of 
features of this dialog box. 

Open Book Dialog Box 

1. Library data - the actual items shown will depend upon what you have installed in your library. 
2. Plus symbol – click to open that bookshelf and display its contents. 
3. Bookshelves – they are similar to folders on your disk drive and they can contain the following 

a. Other Bookshelves 
b. Books 
c. BookSets 
d. Graphics 
e. Dictionaries 
f. Expansion Lexicons (used for "All forms" expansion). 

4. Menus – the LDS View libraries are a closed system where the library items are already interconnected. For 
this reason you can add and delete items from the library but you cannot modify the library properties. The 
features that are not needed are disabled. You can however use the menus to do the following. 
a. Edit BookSets 
b. Edit Books 
c. Installed Library Modules – remove books from the library that you have installed. 



 
* * * * * * * * * * * 

Read the Tutorial on Libraries to learn more about Libraries. This is a list of the features of this 
dialog box. 

Edit BookSet Dialog Box 

1. At the top is the BookSet description and below that is a list of the books in the set. 
2. Add Button (not active) 
3. Remove Button (not active) 
4. Options Button – this only becomes active when a book in the BookSet is selected. Click this button to 

display this menu (for the selected book). 
a. Display (BookSet) – set display options for the selected book when it is part of this BookSet. 
b. Custom Word Lists 
c. Reference Books (not active) 

5. Options Menu – menu at the bottom of the window. 
a. Custom Word Lists – for this BookSet 
b. Permissions (not active) 

 
* * * * * * * * * * * 

Read the Tutorial on Libraries to understand more about Libraries. Custom word lists can be 
associated with either Books or BookSets. This is a list of the features of this dialog box. 

Custom Word Lists Dialog Box 

1. At the top is the list of Custom Word Lists for the Book or the BookSet. 
2. The buttons on the right give you options. 

a. Add – click on this button to create a new Custom Word List. 
b. Modify – click on this button to modify the selected Custom Word List. 
c. Remove – click on this button to remove the selected Custom Word List. 

3. Up/Down arrows – change the sequence of Custom Word Lists. 
 

* * * * * * * * * * * 

Read the Tutorial on Libraries to understand how this dialog box is used. Custom word lists can 
be associated with either Books or BookSets. This is a list of the features of this dialog box. 

Edit Custom Word List Dialog Box 

1. At the top is a box where you type the name of this Custom Word List. 
2. Below is a list of the word lists in the Book or BookSet. 
3. Select the word lists you wish to include in this Custom Word List. 
4. Click OK to save your Custom Word List data. 

 
* * * * * * * * * * * 

Read the tutorial on Libraries to understand Libraries. This is a list of the features of this dialog 
box. 

Edit Book Dialog Box 

1. Book description – at the top and below that is the path where the book is found. 
2. The Options Menu 

a. Custom Word List 
b. Display options 

 
* * * * * * * * * * * 



Read the Tutorial on Book Preferences to understand how this dialog box is used. This is a list of 
the features of this dialog box. 

Display Options Dialog Box 

1. List of tagword types - click on the types you wish to display. 
2. List of reference types - click on the ones you wish to display. The LDS scriptures normally show verse 

codes by defaults. 
3. Options Menu - change the display of both inline graphics and a horizontal scroll bar in Text Windows. 

 
* * * * * * * * * * * 

Read the Tutorial on Libraries to understand more about Libraries. This is a list of the features of 
this dialog box. 

Installed Library Modules Dialog Box 

1. At the top is the list of Installed Library Modules. 
2. Select one and click the Uninstall button. This removes the book from the library and your 

computer. It does not destroy the Electronic Library Installation Module (ELIM) you copied to 
your computer. Use File Explorer (from Windows Mobile) to delete one of these files. 

3. Click the Install button and the software will look for any ELIMs on your computer that have 
not been installed to your library. 

 
* * * * * * * * * * * 

1. This is a normal Windows Open File dialog box. 
Load References Dialog Box 

2. The file being opened is a saved reference list that was created by a search. 
3. The data from this file is then displayed in the Search Results window. 
 

* * * * * * * * * * * 

1. This is a normal Windows Save File dialog box. 
Save References Dialog Box 

2. The file being saved is a reference list created by a search. 
3. The option to save a reference list is available from the File menu of the Search Results 

window. 
* * * * * * * * * * * 

To understand Bookmarks, you might want to read the Tutorial on Bookmarks. This is a list of the 
features of this dialog box. 

Bookmarks Dialog Box 

1. A list of all your bookmarks. 
2. Select a bookmark and "jump" to that location. 
3. The system will open the book if it is not currently open. 

 
* * * * * * * * * * * 

To understand Bookmarks, you might want to read the Tutorial on Bookmarks. This is a list of the 
features of this dialog box. 

Organize Bookmarks Dialog Box 

1. Top center is the display of folders and bookmarks. 
2. The Options menu becomes functional after you have selected an item. 



 
* * * * * * * * * * * 

The title you see is determined by which type of bookmark item was selected prior to the menu 
selection that caused this dialog box to appear on the screen. 

Move Bookmark (Folder) 

1. At the top is the name of the selected bookmark or folder. 
2. Below is a tree of all the folders in your bookmark system. 
3. Select the new parent and click the OK button – the bookmark will be moved. 

 
* * * * * * * * * * * 

The title you see is determined by which type of bookmark item was selected prior to the menu 
selection that caused this dialog box to appear on the screen. 

Rename Bookmark (Folder) 

1. At the top is the current description of the bookmark or folder. 
2. Type the new description below and click the OK button. 

 
* * * * * * * * * * * 

1. At the top is the parent folder (the folder you selected prior to selecting the menu item that 
brought this dialog box to the screen). 

Attach a New Folder 

2. Type the name for the new folder in the box below and click the OK button. 
 

* * * * * * * * * * * 

1. This dialog box lists all the languages available for the LDS View Windows Mobile Edition. 
Options Dialog Box 

2. Select the desired language and click OK. 
3. You will next be asked if you want the software to exit and automatically restart. 
4. If you click No, remember that the software needs to be restarted for the language change to 

take effect. 
 

* * * * * * * * * * * 

1. The version number and build number of the software displayed in this dialog box is useful if 
you every need to contact technical support. 

About Box 

2. Below are the copyright statements for the software and the data. 
 

* * * * * * * * * * * 
  



This is a description of the features of this dialog box. See Search Tutorial for a description of 
the process of building a search. 

Search Dialog Box 

1. Search combo box – this has a list of all the open books. You select which book you wish to 
search. You can choose to search all the open books. 

2. Word list combo box – this has a list of all the word lists of the currently chosen search 
target. 

3. Find box – this is where you type your searches. As you type a spell checker will display the 
nearest word from the chosen word list. 

4. Menus – the Options available from the menus allow you to change the way the search 
works. The Search menu items allow you to use other dialog boxes to refine your search. 
a. Search Logic Dialog Box – select the search logic using options presented in the dialog box. 
b. Attributes of Word Dialog Box – override the word-type, word list and language of a search word. 
c. WordWheel Dialog Box – displays the current word list. The list can be sorted by different fields and search 

words can be selected. 
 

* * * * * * * * * * * 

1. This dialog box is designed to allow you to select your search logic using controls. 
Search Logic Dialog Box 

2. You select the Boolean logic, the type of separation of the words and the order of the words. 
3. See the tutorial on Search Logic for more details. 

 
* * * * * * * * * * * 

1. In order to use this dialog box you must understand the concept of word-type. The possible 
word-types are the following. 

Attributes of Word Dialog Box 

a. None (no word-type has been specified) 
b. Normal (word) 
c. Group (a group of adjacent words treated as a single word) 
d. Ruby Text (superscripted or subscripted text that is either commentary or an alternative form of the word) 
e. Subword (punctuation or special commentary inserted by publishers) 
f. Tagword (explanatory "words" added to another word – e.g. part-of-speech codes, definitions, root form of 

the word, etc.). 
2. Using this dialog box you can do the following. 

a. Assign the word-type for the selected word. 
b. Assign the language for the selected word. 
c. Override the All Forms option in searching by indicating that the selected word should not be expanded into 

all forms during the search. 
3. This is an example of using special word-type in a search. 

a. To find every sentence that is a question that ends in thou we would type thou [space] &.0 [space] ^? 
b. With the cursor on the "^?" token, use the Search menu and select "Attributes of Word" from the list. 
c. In the dialog box, select "Subword" from the Word-type list and click OK. 
d. This appends a small S to the ^?. The search results show sentences that are questions that end in thou. 
 

* * * * * * * * * * * 
  



1. The purpose of this dialog box is to present the words that comprise the selected word list. 
WordWheel Dialog Box 

2. Which words are shown in this list is impacted by these options from the Search dialog box. 
a. Ignore case:  with this option all words are shown with lower case characters (e.g. LORD, LORD and Lord in 

the English scriptures would be concatenated into the one WordWheel entry of lord.) 
b. Ignore diacritics:  multiple words that differ only in diacritics are combined into one WordWheel entry (e.g. in 

the Spanish scriptures, atravesara and atravesará become atravesara). 
c. Ignore word-type:  multiple words, that differ only in their word-type code, are combined into one 

WordWheel entry (e.g. in the English scriptures with the "All text" word list, there are two related words: 
authority and authorityT - one is in the normal scripture text and the other is a tag word. With this option 
they are merged into one entry). 

3. You can sort the list by the data in any of the columns. 
4. If you type a word without hesitation, the list will position to that word. 
5. If you double click on a word, that word will become your search word and its search results 

will be automatically displayed. 
6. If you click on a group of words and click OK, that group will be appended to the current 

search in the Search Dialog box. 
 

* * * * * * * * * * * 

1. The table of contents for the current book. 
Table of Contents Dialog Box 

2. Use the tree control to select a part of the book. Click on the plus sign in front of an entry to 
see any child items.  

3. Click OK and the Text Window will reposition to the selected location. 
 

* * * * * * * * * * * 

With this dialog box you can add a bookmark (see Bookmark Tutorial) to the system. The 
following are the features of bookmarks and this dialog box. 

Add Bookmark Dialog Box 

1. The default name of the bookmark is the citation for the location of the text in upper left 
corner of the text window. You can override this and type your own name. 

2. The default parent in the bookmarks tree is the name of the book. You can override this and 
create your own folder or rename the default folder. 

3. Options menu 
a. Attach a new folder – create a new folder and then select its parent 
b. Rename folder – select a folder and rename it. 
c. Delete folder – select a folder and delete it. 

 
* * * * * * * * * * * 

1. At the top is the parent folder (the folder you selected prior to selecting the menu item that 
brought this dialog box to the screen). 

Attach a New Folder 

2. Type the name for the new folder in the box below and click the OK button. 
 

* * * * * * * * * * * 
  



This option can only be used to change the name of a newly added bookmark folder. 
Rename Bookmark Folder 

1. At the top is the current description of the bookmark or folder. 
2. Type the new description below and click the OK button. 

* * * * * * * * * * * 

1. This report is available from the Results menu of the Search Results window. 
Frequency Distribution Dialog Box 

2. This report displays where the current search results occur by presenting the table of 
contents for the search book and by showing the items that contain search hits. 

3. Initially the results are shown for the top level only (e.g. Volume for LDS Scriptures). 
4. When the table of contents contains subdivisions for a table entry, you will see a plus sign in 

a box to the left of the entry name. Click on the plus and it will expand the parent entry and 
display its child entries that contain search hits (e.g. Book of Mormon -> 2 Nephi, Jacob, 
Mosiah, Alma, Helaman, Moroni). 

5. Once you have expanded an entry in the table to display child items, you can close up that 
expansion by clicking the minus sign in front of the parent item. 

6. When you have clicked on a table entry to select it, you can click on the Options menu and 
select one of the following. 
a. Delete this item – remove this item from the Frequency Distribution and from the Search Results. 
b. Keep only this item – remove everything except this item from the Frequency Distribution and from the 

Search Results. 
c. View Details to see more information about this entry. 

* * * * * * * * * * * 

1. There are ten possible data fields you can display for any table of contents item from the 
Frequency Distribution report. 

Details Dialog Box 

a. Actual Frequency – search hits occurring within the bounds of this table of contents item. 
b. Expected Frequency – given the number of search hits, how many you would expect to find within this table 

item based upon its size relative to the entire search book. Frequently this is a number less than 1. The 
number is reported with one decimal point. 

c. Difference – Actual Frequency minus Expected Frequency 
d. Total Frequency – Total number of words in this table item. 
e. Actual percent – Actual Frequency divided by the number of search hits and multiplied by 100. 
f. Expected percent – Expected Frequency divided by the number of search hits and multiplied by 100.  
g. Difference percent – Actual percent minus Expected percent 
h. Total Percent – Total Frequency divided by the number of words in the search book and multiplied by 100. 

This item is useful for knowing what percent a given table item is of the entire book (e.g. Old Testament: 
50.1%) 

i. Rating – a statistic indicating the relative strength of the search hits in a table item (e.g. a larger number 
means the search words occur more frequently than would be expected by chance). 

j. Actual % / Expected % - two graphic bars whose length displays the relative values of these two numbers. 
When these numbers are small there is intentional distortion of this data so the bars can be seen. The 
relative length of each bar to one another is significant not their absolute lengths. 

2. You can click on the Options menu and select one of the following. 
a. Show / hide items – from a list of all possible detail fields you can select which you wish to see. 
b. Allow items to be moved – clicking this item displays arrows in the Details dialog box. If you select a field 

from the report you can use these arrows to move the field up or down in the list. If you click the Options 
menu item again you will see a check box on this item indicating it is active. Click it again and it becomes 
inactive and the move arrows are removed from the Details display. 

c. Return – click this to close the Details dialog box and return to Frequency Distribution. 



>>>>>      <<<<< 
* * * * * * * * * * * 

The menus of the Windows Mobile Edition of LDS View appear at the bottom of each window. 
Some menu items may be disabled (gray color) because the item is not active at the moment. 

Menus 

Options 
Add Bookmark dialog box 

1. Attach a new folder… 
2. Rename folder… - calls the Rename Folder dialog box. This is only active for a folder created by "Attach a 

new folder" above. 
3. Delete folder – this applies only to a folder created by "Attach a new folder" above. 

Options 
Frequency Distribution details dialog box 

See the Details Dialog box for a description of each of the fields listed below. 
1. Show / hide items 

a. Actual Frequency 
b. Expected Frequency 
c. Difference 
d. Total Words 
e. Actual Percent 
f. Expected Percent 
g. Difference Percent 
h. Total Percent 
i. Rating 
j. Actual% / Expected% 

2. Allow items to be moved 
3. Return 

Options 
Frequency Distribution dialog box 

Select an item in the dialog box before these menu options become active. 
1. Delete this item 
2. Keep only this item 
3. View details – brings the Details Dialog Box to the screen. The listed fields contain information about the 

selected item. 

  



File 
Graphic Window 

1. Open… 
2. Close 
3. Options… 

a. Open Help Book 
b. Load References… 
c. Preferences… 
d. Bookmarks… 
e. Organize Bookmarks… 
f. Check for Updates… 

4. About WordCruncher… 
5. Exit 

Graphic 
1. Tool 

a. Select 
b. Move 
c. Zoom 
d. Zoom Out 

2. Best Fit 
3. Actual Size 
4. Screen Resolution 
5. Go 

a. Back 
b. Forward 
c. Next Image 
d. Previous Image 

File 
Main Window 

1. Open 
2. Close 
3. Options… 

a. Open Help Book 
b. Load References… 
c. Preferences… 
d. Bookmarks… 
e. Organize Bookmarks… 
f. Check for Updates… 

4. About WordCruncher… 
5. Exit 

  



Options 
Open Book Dialog box 

1. Add Book… (Not active for LDS View) 
2. Add BookSet… (Not active for LDS View) 
3. Add Graphic… (Not active for LDS View) 
4. Add Bookshelf… (Not active for LDS View) 
5. Remove (Not active for LDS View) 
6. Installed Modules… 
7. Properties…

Options 
Edit Book Dialog box 

1. Display… 
2. Note Files… (Not active for LDS View) 
3. Custom Word Lists 
4. Reference Books (Not active for LDS View) 
5. Permissions… (Not active for LDS View) 
6. Use as a lexicon (Not active for LDS View) 
7. Hide this book (Not active for LDS View) 

Options 
Display Options Dialog box 

1. Superscripts or subscripts (Not active for LDS View) 
2. Ruby text (Not active for LDS View) 
3. Inline graphics as icons 
4. Horizontal scroll bar 
5. Default table of contents (Not active for LDS View) 
Options 
1. Reposition other books (Not active for LDS View) 
2. Allow repositioning (Not active for LDS View) 

 

Options 
Edit BookSet Dialog box 

1. Custom Word Lists… 
2. Permissions… (Not active for LDS View) 
3. Show footnotes (Not active for LDS View) 
4. Hide this BookSet (Not active for LDS View) 
5. Default table of contents (Not active for LDS View) 

Sync 
1. Reposition other books… (Not active for LDS View) 
2. Allow Repositioning… (Not active for LDS View) 

Options Button 
1. Display (BookSet)… 
2. Custom Lexicons 
3. Reference Books (Not active for LDS View) 
4. Footnotes Pane (Not active for LDS View) 
5. Set master book (Not active for LDS View) 
6. Sync table of contents (Not active for LDS View) 



Options 
Display (BookSet) Dialog box 

1. Superscripts or subscripts 
2. Ruby text 
3. Inline graphics as icons 
4. Horizontal scroll bar 

Options for bookmark 
Organize Bookmarks Dialog Box 

1. Move this bookmark… - calls the Move bookmark dialog box. 
2. Delete this bookmark 
3. Rename this bookmark… – calls the Rename bookmark dialog box. 
Options for folder 
1. Move this folder… - calls the Move folder dialog box. 
2. Delete this folder 
3. Rename this folder… - calls the Rename folder dialog box. 
4. Attach a new folder… - calls the Attach a New Folder dialog box. 

Options – click to show check mark; unclick again to uncheck the option. The explanations 
below refer to options in their checked status. 

Search Dialog Box 

1. Use All Word Forms: all search words are expanded (using a language specific expansion 
lexicon) into all the forms of a given word in the search. 

2. Ignore Case: all words are displayed on the WordWheel with lower-case letters only (the 
way they are written in the book is ignored). 

3. Ignore Diacritics: all words are displayed on the WordWheel without diacritics. 
4. Ignore Word-type: where a single word may appear multiple times on the WordWheel, one 

for each of the different possible word-types (e.g. normal, subword, tagword, ruby text and 
group), when this option is selected there will be only one word on the WordWheel and it 
will not have any of the word-type identifiers. However, searching for one of these words 
will find all the occurrences (no matter the word-type) of that word in the selected word list. 

 
Search 
1. Search Logic… 
2. Attributes of Word… 
3. WordWheel… 

Options 
Search Logic Dialog Box 

1. Command Abbreviations: this option is either checked or unchecked. 
a. Checked: the command string created by this dialog box will use the abbreviated commands (e.g. &.5 as in a 

search argument like and &.5 pass). 
b. Unchecked: the command string create by this dialog box will use the regular version of commands (e.g. 

And.5 as in the search argument and And.5 pass) 

  



File 
Search Results Window 

1. Open… 
2. Close 
3. Options 

a. Open Help Book 
b. Load References… 
c. Save References… 
d. Preferences… 
e. Bookmarks… 
f. Organize Bookmarks… 
g. Check for Updates… 

4. About LDS View… 
5. Exit 
Results 
1. Search for word(s)… 
2. Frequency Distribution 
3. Go 

a. Back 
b. Forward 

1. Space Character [^space] 
Search – Symbol Popup 

2. Asterisk [^*] 
3. Question Mark [^?] 
4. Left Parenthesis [^(] 
5. Right Parenthesis [^)] 
6. Double Quote [^"] 
7. Apostrophe [^'] 
8. Caret [^^] 
9. Ampersand [^&] 

  



File 
Text Window 

1. Open… - call the Open Book dialog box so you can open other books. 
2. Close – close the book in the text window. 
3. Options 

a. Open Help Book – open and close this book. 
b. Load References… - load saved search results. 
c. Preferences… - call the Preferences dialog box (change the language of the software) 
d. Bookmarks… - see you current bookmarks in the Bookmarks dialog box. 
e. Organize Bookmarks… - see the Organize Bookmarks dialog box. 
f. Check for Updates… 

4. About LDS View… - see copyright and build information for the software and library items. 
5. Exit – close LDS View 
Book 
1. Search for word(s)… - setup a search. 
2. View 

a. Footnotes – show or hide the footnote pane. 
b. Tagwords – show tagwords in the window. 
c. Word Highlights – when search words are shown highlighted in the text window this menu item becomes 

active. Click this menu item to remove search word highlighting. 
3. Go 

a. Back – in a hyperlink chain, show the previous location. 
b. Forward – in a hyperlink chain, show the next location. 
c. Next Reference – when the text window is displaying search results, see the next search result. 
d. Previous Reference – when the text window is displaying search results, see the previous search result. 
e. Table of Contents– displays the table of contents. 

4. Add Bookmark… – for the current location. 

Options 
WordWheel dialog box 

1. Sort – sort the listed column in the listed order. 
a. Word – ascending 
b. Word – descending 
c. Frequency – ascending 
d. Frequency- descending 
e. Length – ascending 
f. Length - descending 

2. Click multiselect – this item toggles the multiple selection mode of the list box of the 
WordWheel. The two states of multiselect are explained below.  
a. Checked – Single click on a WordWheel item to select it. Click again on a selected item to unselect it. If you 

hold down the shift key when you select, all the items between your previous selected item and this new item 
are selected. 

b. Unchecked – If you click on an item to select it, the action will unselect any other selected items. If you hold 
down the shift key when you select, all the items between your previous selected item and this new item are 
selected. In Windows Mobile, there is no equivalent to holding down the control key and clicking an item for 
the multiselecting of single items. That is the reason for this option. 
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